Crystal Reports Installation Guide
Version XI

Infor Global Solutions, Inc.
Copyright © 2006 Infor IP Holdings C.V. and/or its affiliates or licensors. All rights reserved. The Infor word and design marks are trademarks and/or registered trademarks of Infor IP Holdings C.V. and/or one of its affiliates. All rights reserved. All other trademarks listed herein are the property of their respective owners.

This documentation corresponds Crystal Reports Installation Instructions version XI.

Information in this document is subject to change without notice. Infor Global Solutions is not responsible for typographical errors.

Companies, names, and data used in examples herein are fictitious unless otherwise noted.

Microsoft, MS, and MS-DOS are registered trademarks and Windows and Windows NT are registered trademarks of Microsoft Corporation.

GUPTA Team Developer, SQLTalk, and SQLBase are trademarks or registered trademarks of Gupta Technologies, LLC.

Oracle 9i is a trademark of Oracle Corporation and/or its affiliates.

Intel, Pentium, and Pentium III Xeon are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

All other names mentioned in this book are trademarked or copyrighted by their respective manufacturers.
Contents

Before You Begin .............................................................................................................................. 1
Installation and Set Up Procedures ................................................................................................. 1
   Installing or Upgrading Crystal Reports on Servers ................................................................. 1
      Configuring CMS..................................................................................................................... 7
   Installing Crystal Reports on Client Machines ...................................................................... 11
   Upgrading Crystal Reports on Client Machines .................................................................... 15

Working with Reports...................................................................................................................... 19
   Creating Reports ..................................................................................................................... 19
   Publishing Reports ................................................................................................................. 21
   Running Reports ..................................................................................................................... 26
Before You Begin

PLEASE READ ALL OF THESE INSTRUCTIONS PRIOR TO BEGINNING INSTALLATION OR UPGRADING

**Oracle** – So that the CMS can connect to your Oracle VE database, you must install the Oracle compliant components.

**SQLBase** – CMS requires a SQLBASE runtime and 9.01 driver-pack to connect to your SQLBASE VE database. You must also set up an ODBC DSN to connect to the SQLBase database. The DSN name must match the CMS Name and be present on ALL client computers.

### Installation and Set Up Procedures

The installation of Crystal Reports version XI consists of:

1. Install Crystal Reports on your server
2. Configure the Crystal Management Server
3. Install Crystal Reports on your client machines
4. Create the report you want publish.
5. Publish the reports to which you want to allow access

### Installing or Upgrading Crystal Reports on Servers

Time required for installation: 2 hours.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>To install Crystal Reports on servers:</td>
<td></td>
</tr>
</tbody>
</table>
| 1. | Place the Crystal Reports CD-ROM in the CD-ROM drive.  
If the install program does not automatically start, use Windows Explorer to navigate to the CD-Rom and double-click on the **Setup.exe** file. |
| 2. | Click on the **Install Crystal Reports Server** button. |
3. The Welcome dialog box appears. Click on the **Next** button.

If you are running Windows XP and have Service Pack 2 or higher installed, a prompt appears notifying you that you may have to enable the BusinessObjects Enterprise servers to receive incoming requests through the firewall. Click the **OK** button.

4. The License Agreement dialog box appears.
Read the License Agreement and, if you agree with it, select the **I accept the License Agreement** option.
Click the **Next** button.
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>5.</td>
<td>The Select Client or Server Installation dialog box appears. Select the <strong>Perform Server Installation</strong> option. Click the <strong>Next</strong> button.</td>
</tr>
<tr>
<td></td>
<td><img src="image1.png" alt="Select Client or Server Installation" /></td>
</tr>
<tr>
<td>6.</td>
<td>The User Information dialog box appears. Enter: Your Name The Name of your organization The Product Key Click the <strong>Next</strong> button.</td>
</tr>
<tr>
<td></td>
<td><img src="image2.png" alt="User Information" /></td>
</tr>
<tr>
<td>7.</td>
<td>The Directory Selection dialog box appears. If you want to install Crystal Reports to a different directory, click the <strong>Browse</strong> button and select the directory you want. Click the <strong>Next</strong> button.</td>
</tr>
<tr>
<td></td>
<td><img src="image3.png" alt="Directory Selection" /></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>8.</td>
<td>The Install Type dialog box appears. Select the New option and click the <strong>Next</strong> button.</td>
</tr>
<tr>
<td></td>
<td><img src="image1.png" alt="Install Type dialog box" /></td>
</tr>
<tr>
<td>9.</td>
<td>The Choose Web Component Adapter dialog box appears. Select the Java application server check box and the option you want to use for this server set up. If you already have the IIS (Internet Information Service) installed and want to continue using it, select the IIS option. Click the <strong>Next</strong> button.</td>
</tr>
<tr>
<td></td>
<td><img src="image2.png" alt="Choose Web Component Adapter dialog box" /></td>
</tr>
<tr>
<td>10.</td>
<td>If you selected to install the Tomcat application server, the configure Tomcat dialog box appears. <strong>Note:</strong> Because you may have to configure your firewall settings, take note of the port numbers Click the <strong>Next</strong> button.</td>
</tr>
<tr>
<td></td>
<td><img src="image3.png" alt="Configure Tomcat dialog box" /></td>
</tr>
</tbody>
</table>
11. The MSDE Security Configuration dialog box appears. Enter a password for the MSDE (MS Data Engine) default sa account and confirm the password in the Confirm field. Click the **Next** button.  
*Note: If you have SQL Server installed the install program will ask you for a password for the existing engine.*

![MSDE Security Configuration](image)

12. The Start Installation dialog box appears. Click the **Next** button.

![Start Installation](image)

A dialog box appears indicating the progress of the installation process.

![Progress Indication](image)

13. Depending on the components you are installing, a dialog box appears requesting you to insert the second installation disk. Insert Disk 2 and click the **OK** button.
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>14.</td>
<td>When the installation is complete, the Register Wizard appears. Click the <strong>Next</strong> button.</td>
</tr>
<tr>
<td>15.</td>
<td>If you are registered member, click the <strong>I am a registered member</strong>… option and enter your registration number. Click the <strong>Finish</strong> button.</td>
</tr>
<tr>
<td>16.</td>
<td>The Registration Complete dialog box appears. Clear the <strong>Launch BusinessObjects Administration Console</strong> check box. Click the <strong>Finish</strong> button.</td>
</tr>
<tr>
<td>17.</td>
<td>The Setup has completed dialog box appears. Click the <strong>Yes</strong> button to restart your computer.</td>
</tr>
</tbody>
</table>
**Configuring CMS**

Time required for installation: 2 hours.

Make sure you have the correct components installed on your machine for the following database engines:

*Note: If you are using a Firewall, make sure it will allow access on Port 6400 or is turned off.*

<table>
<thead>
<tr>
<th>To configure your Crystal Management Server:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Start the Business View Manager. When the Business Views Manager login dialog box appears, log in using a blank password. When the welcome dialog box appears, click the <strong>Cancel</strong> button. From the Tools menu, select <strong>Import</strong>.</td>
</tr>
<tr>
<td><img src="image1.png" alt="Business View Manager" /></td>
</tr>
<tr>
<td>2. The Import dialog box appears. Click the <strong>Choose XML...</strong> button, navigate to your VISUAL executables directory and select the LSAVIEWS.XML file for import. Click the <strong>OK</strong> button. <em>Note: The LSAVIEWS.xml file is part of your VISUAL installation.</em></td>
</tr>
<tr>
<td><img src="image2.png" alt="Import" /></td>
</tr>
<tr>
<td>3. The Successful Import dialog box appears. Click the <strong>OK</strong> button.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Successful Import" /></td>
</tr>
</tbody>
</table>
4. Edit the CMS database connection by selecting **Open** from the File menu.

   *Note: This is the Business Views connection to your VISUAL database.*

   Select the connection you want to use and click the **Open** button.

5. Edit the database connection by selecting **Edit** from the Edit menu. The Choose a Data Source dialog box appears.

   Select the data source that is appropriate for your database type and click the **OK** button.

   *Note: If you are on SQLBase, use ODBC (RDO).*
6. The OLE DB Provider dialog box appears. Select the Provider that is appropriate for your database type. Click the **Next** button.  
*Note: If you are using SQLBase, choose the DSN you previously set up, if you are using Oracle, select the Oracle Provider for OLE DB.*

![OLE DB Provider dialog box](image)

7. The Connection Information dialog box appears. Enter:  
**Server** – Click the drop-down arrow and select the server on which your database resides.  
**User ID** – Enter a log in user identification.  
**Password** – Enter the password for the user.  
**Database** – Click the drop-down arrow and select the name of the database.  
**Integrated Security** – Select the check box if you want to use integrated security.  
Click the **Finish** button.

![Connection Information dialog box](image)
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>8.</td>
<td>The connection you made appears in the Choose a data Source dialog box. Click the <strong>OK</strong> button.</td>
</tr>
<tr>
<td>9.</td>
<td>The Set Data Connection Password dialog box appears. Enter the User Name and Password and confirm the password by entering it a second time. Click the Runtime Prompt Mode drop-down arrow and select the <strong>Never Prompt</strong> option. Click the <strong>OK</strong> button.</td>
</tr>
<tr>
<td>10.</td>
<td>Click the <strong>Save</strong> toolbar button.</td>
</tr>
<tr>
<td>11.</td>
<td>From the File menu, select <strong>Exit</strong>.</td>
</tr>
</tbody>
</table>
# Installing Crystal Reports on Client Machines

Time required for installation: 2 hours.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | Make sure your VISUAL.INI file has `UserReports=Y`.  
*Note: If the User Reports menu does not appear, check your VISUAL.ini file first.*  
[Visual Mfg]
UserReports=Y |
| 2.   | Place the Crystal Reports CD-ROM in the CD-ROM drive.  
If the install program does not automatically start, use Windows Explorer to navigate to the CD-Rom and double-click on the Setup.exe file. |
| 3.   | Click on the **Install Crystal Reports** button. |
| 4.   | The Welcome dialog box appears.  
Click on the **Next** button. |
5. The License Agreement dialog box appears. Read the License Agreement and, if you agree with it, select the **I accept the License Agreement** option. Click the **Next** button.

6. The Select Client or Server Installation dialog box appears. Select the **Perform Client Installation** option. Click the **Next** button.

7. The User Information dialog box appears. Enter:
   - Full Name
   - The Name of your organization
   - The Product Key
Click the **Next** button.
<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.</td>
<td>The Select Installation Type dialog box appears. Select the <strong>Typical</strong> option. If you want to install Crystal reports to a different directory, click the <strong>Browse</strong> button next to the Destination Folder section and select the directory you want. If you want to install Crystal Reports’ common files to a different directory, click the <strong>Browse</strong> button next to the Common Files Folder section and select the directory you want. Click the <strong>Next</strong> button.</td>
</tr>
<tr>
<td>9.</td>
<td>The Start Installation dialog box appears. Click the <strong>Next</strong> button.</td>
</tr>
<tr>
<td>10.</td>
<td>A dialog box appears indicating the progress of the installation process.</td>
</tr>
</tbody>
</table>
11. When the installation is complete, the Register Wizard appears. Click the **Next** button.

12. If you are registered member, click the **I am a registered member…** option and enter your registration number. Click the **Finish** button.

13. The Setup has completed dialog box appears. Click the **Yes** button to restart your computer.
14. Clear the **Check for Product Updates** checkbox and click the **Finish** button.
   If you have the time, select the **Check for product updates** check box.

---

### Upgrading Crystal Reports on Client Machines

Time required for installation: 2 hours.

**To upgrade Crystal Reports on servers:**

1. Place the Crystal Reports CD-ROM in the CD-ROM drive.
   If the install program does not automatically start, use Windows Explorer to navigate to the CD-ROM and double-click on the Setup.exe file.

2. Click on the **Install Crystal Reports** button.
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>3.</td>
<td>The Welcome dialog box appears. Click on the <strong>Next</strong> button.</td>
</tr>
<tr>
<td></td>
<td><img src="image1.png" alt="Image of the Welcome dialog box" /></td>
</tr>
<tr>
<td>4.</td>
<td>The License Agreement dialog box appears. Read the License Agreement and, if you agree with it, select the <strong>I accept the License Agreement</strong> option. Click the <strong>Next</strong> button.</td>
</tr>
<tr>
<td></td>
<td><img src="image2.png" alt="Image of the License Agreement dialog box" /></td>
</tr>
<tr>
<td>5.</td>
<td>The User Information dialog box appears. Enter: Full Name The Name of your organization The Product Key Click the <strong>Next</strong> button.</td>
</tr>
<tr>
<td></td>
<td><img src="image3.png" alt="Image of the User Information dialog box" /></td>
</tr>
</tbody>
</table>
6. The Select Installation Type dialog box appears. 
   Select the **Typical** option. 
   If you want to install Crystal reports to a different directory, click the **Browse** button next to the Destination Folder section and select the directory you want. 
   If you want to install Crystal Reports’ common files to a different directory, click the **Browse** button next to the Common Files Folder section and select the directory you want. 
   Click the **Next** button.

7. The Start Installation dialog box appears. 
   Click the **Next** button.

8. A dialog box appears indicating the progress of the installation process.
9. When the installation is complete, the Register Wizard appears. Click the **Next** button.

10. If you are registered member, click the **I am a registered member**… option and enter your registration number. Click the **Finish** button.

11. The Setup has completed dialog box appears. Click the **Yes** button to restart your computer.

12. Clear the **Check for Product Updates** checkbox and click the **Finish** button.

If you have the time, select the **Check for product updates** checkbox.
## Working with Reports

After you have created your reports using Crystal Reports and the appropriate VISUAL report template, you can view and print those reports using either Crystal Reports or VISUAL. If you want to allow access to your reports for those without Crystal Reports or VISUAL, you must publish the reports to your CMS Server: published reports are available from any web browser using a standard internet connection.

## Creating Reports

<table>
<thead>
<tr>
<th>To create reports:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Start VISUAL and open the window for which you are creating the report. For example, open the Part Maintenance window if you want to create a report that includes your part information.</td>
</tr>
<tr>
<td>2. From the User Reports menu, select the <strong>Edit</strong> option. The User reports dialog box appears.</td>
</tr>
<tr>
<td>3. Click the Report Name drop-down arrow and select the report template you want to use for your new report. Click the <strong>Edit</strong> button.</td>
</tr>
</tbody>
</table>
4. Crystal Reports starts and you are requested to Log On to BusinessObjects Enterprise. Make sure the appropriate system name appears in the System field and enter a User Name and Password. Click the OK button.

5. In the Field Explorer section, double-click the **Database Fields** node. The field names that appear are the fields available for your report. 
   *Note: You may have to click the plus sign to the right of the name to access the field name you want to use.*

6. Click and drag the fields you want to use for your report onto the Details section.

7. Continue to add data fields to your report until it contains the information you want. To view your finished report, or to view your progress, click the
8. When you have finished building your report, click the **Save As** option on the File menu.

9. If you want others to use this report, you must save it to a public folder. If you plan on publishing this report, your CMS Server must have access to the folder in which you save the report. Navigate to where you want to save this report and save the new report using the name you want. Click the **Save** button on the Save As dialog box.

### Publishing Reports

In order to view or print reports, you must either open the VISUAL window in which the report resides or publish the report to the CMS Server so that users can use a standard web browser and an internet connection for report access.

**To publish reports:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2.</td>
<td>The Welcome dialog box appears. Click the <strong>Next</strong> button.</td>
</tr>
</tbody>
</table>
3. The Log On to BusinessObjects Enterprise dialog box appears. Enter:
   - **Server** – Enter the name of the system on which your Business Objects reside.
   - **User Name** – Enter a log in user identification.
   - **Password** – Enter the password for the user.
   - **Authentication** – Click the drop-down arrow and select the type of authentication you want to use. Click the **Next** button.

4. The Select Files dialog box appears. Click the **Add Files** button.

5. Navigate to and select the report you want to publish. Click the **Next** button.
6. The Specify Location dialog box appears. 
Select the folder name where you want to store the published report. 
You may want to create different directories for different types of reports. 
Click the Next button.

7. The Confirm Location dialog box appears. 
If you want to view the names of your published reports that reside in the directory, click the Plus icon to the left of the folder name. 
Click the Next button. 
**Note:** Because the published report resides on the CMS Server, you can use a different naming convention than VISUAL.

8. The Specify Categories dialog box appears. 
**EXPLANATION** 
Click the Next button.
9. The Specify Schedule dialog box appears.
   In the list box, select the report names for which you want to specify a schedule. Select the appropriate schedule option. You can select:
   - **Run once only** – Create the report and fill it with data one time only.
   - **Let users update the object** – Allow the users to fill the report with new data upon request.
   - **Run on a recurring schedule** – Update the report at specified intervals.
   Click the Next button.

10. The Specify Repository Refresh dialog box appears.
    **EXPLANATION**
    Click the Next button.

11. The Keep Saved Data dialog box appears.
    **EXPLANATION**
    Click the Next button.
12. The Change Default Values dialog box appears. Select the **Publish without modifying properties** option. Click the **Next** button. If you want to review or change the properties for this report, click the **Review or modify properties** option and click the **Next** button. A dialog box appears giving the opportunity to review and change the properties of this report.

A details dialog box appears populated with the report you are publishing.

13. When Crystal Reports has finished publishing your report, the report appears in the list. To view the details of that report, click on the report in the list and the details appear in the Details field. Click the **Finished** button.
Running Reports

You do not need to have Crystal reports or VISUAL installed on your computer to access your reports.

To run reports:

1. Start web browser.

2. In the Address field, enter the link to your CMS. Use the following syntax:
   You can also set up a link on a web page using the same syntax or save the link in a bookmark.

3. If you are using a link through a web page, navigate to the appropriate Crystal Reports server.

4. Click the link for your CMS Server.
5. Click the Info View link.

6. The log on page appears. Enter your Username and Password. Click the Log On button.
The Crystal Reports server appears in your browser.

7. In the left pane, navigate to the folder that contains the report you want to run. A list of available reports appears in the right pane. Click on the name of the report you want to run.

8. The report you want appears in the right pane.